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FEATURES 
Full featured evaluation board for the AD7173-8 
PC control in conjunction with the SDP (see EVAL-SDP-CB1Z 

from Analog Devices, Inc. for additional information) 
PC software for control and data analysis (time domain)  
Standalone capability 

EVALUATION KIT CONTENTS  
EVAL-AD7173-8SDZ evaluation board  
AD717x Eval+ software CD  
7 V to 9 V ac-to-dc adapter 

EQUIPMENT NEEDED 
DC signal source 
PC running Windows® XP to Windows 10 

 

 

 

GENERAL DESCRIPTION 
The EVAL-AD7173-8SDZ evaluation kit features the  
AD7173-8, a 24-bit, 31.25 kSPS analog-to-digital converter 
(ADC) with integrated analog input buffers, on-board power 
supply regulation, and an external amplifier section for 
amplifier evaluation. A 7 V to 9 V ac-to-dc adapter is regulated 
to 5 V and 3.3 V; this supplies the AD7173-8 and support 
components. The EVAL-AD7173-8SDZ board connects to a 
USB port via the system demonstration platform (SDP) 
EVAL-SDP-CB1Z (SDP-B) controller board.  

The AD717x Eval+ software fully configures the AD7173-8 
device functionality via a user accessible register interface and 
provides dc time domain analysis in the form of waveform 
graphs, histograms, and associated noise analysis for ADC 
performance evaluation. 

 

FUNCTIONAL BLOCK DIAGRAM 

 
Figure 1. EVAL-AD7173-8SDZ Block Diagram 
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EVAL-AD7173-8SDZ QUICK START GUIDE 
RECOMMENDED QUICK START GUIDE 
Follow these steps to set up the board: 

1. Disconnect the SDP-B board from the USB port of the PC. 
Install the AD717x Eval+ software from the enclosed CD. 
Restart the PC after installation. 

2. Connect the SDP-B board to the EVAL-AD7173-8SDZ 
board, as shown in Figure 2. 

3. Fasten the two boards with the enclosed plastic  
screw washer set. 

4. Connect the external 9 V power supply to Connector J4 of 
the EVAL-AD7173-8SDZ board as shown in Figure 2. Set 
LK2 to Position B. 

5. Connect the SDP board to the PC via the USB cable. For 
Windows® XP, you may need to search for the SDP drivers. 
Choose to automatically search for the drivers for the SDP-B 
board if prompted by the operating system. 

6. Launch the AD717x Eval+ software from the Analog 
Devices subfolder in the Programs menu. 

QUICK START NOISE TEST 
Use the following procedure to quickly test the noise 
performance: 

1. Insert Link LK5 to Link LK20 to initiate the noise 
performance test mode. In this mode, analog input 
channels short to the REFOUT pin via SL11. 

2. Click Start Sampling to acquire samples from the ADC 
(see Figure 16). 

The Samples numeric control in the top right corner of the 
main window sets the number of samples collected in each 
batch. 

 
Figure 2. Hardware Configuration, Setting Up the EVAL-AD7173-8SDZ 
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EVALUATION BOARD HARDWARE 
DEVICE DESCRIPTION 
The AD7173-8 is a highly accurate, high resolution, multiplexed, 
8-/16-channel (full/pseudo differential) Σ-Δ ADC. The AD7173-8 
has a maximum channel-to-channel scan rate of 6.21 kSPS (161 µs) 
for fully settled data The output data rates range from 1.25 SPS 
to 31.25 kSPS. The device includes integrated analog input and 
reference buffers, an integrated precision 2.5 V reference, and 
an integrated oscillator. 

See the AD7173-8 data sheet for complete specifications. Consult 
the data sheet in conjunction with this user guide when using 
the evaluation board. Full details for the SDP-B are available on the 
Analog Devices website. 

HARDWARE LINK OPTIONS 
See Table 1 for default link options. By default, the board is 
configured to operate from the supplied 9 V ac-to-dc adapter 
connected to Connector J4. The 5 V supply required for the 
AD7173-8 comes from the on-board low dropout regulator 
(LDO). The ADP1720, with a 5 V fixed output voltage, receives 
its input voltage from J2 or J4 (depending on the position of 
LK2) and generates a 5 V output. 

 

 

 

 

Table 1. Default Link and Solder Link Options 
Link  Default Option Description 
LK1 A Selects the voltage applied to the power supply sequencer circuit (U3); dependent on AVDD1. Place in 

Position A if using 5 V AVDD1, or Position B if using 2.5 V AVDD1. 
LK2 B Selects the external power supply from Connector J3 (Position A), or J4 (Position B). 
LK5 to LK20 Inserted Inserting these links sets up the on-board noise test. In this mode, all inputs short to the common 

voltage via SL11. 
SL0 A Routes A0 to: AIN0/REF2− pin on the AD7173-8 (Position A), Buffer U6 (Position B), U7 for use with a 

single-ended to differential driver circuit (Position C), or J15-1 (Position D).  
SL1 A Routes A1 to: AIN1/REF2+ pin on the AD7173-8 (Position A), Buffer U6 (Position B), U7 for use with a 

single-ended to differential driver circuit (Position C), or J15-7 (Position D). 
SL2 A Routes A2 to: AIN2 pin on the AD7173-8 (Position A), Buffer U10 (Position B), or U9 for use with a single-

ended to differential driver circuit (Position C). 
SL3 A  Routes A3 to: AIN3 pin on the AD7173-8 (Position A), Buffer U10 (Position B), or U9 for use with a single-

ended to differential driver circuit (Position C). 
SL4 A Sets the voltage applied to the AVDD2 pin. Operates using the AVDD1 supply (default). Position B sets 

the AVDD2 voltage to 3.3 V supply from the ADP1720 (3.3 V) (U11) regulator. 
SL5 B Selects between an external or on-board IOVDD source. Supplies IOVDD from the ADP1720 (3.3 V) (U11) 

(default). The evaluation board operates with a 3.3 V logic. 
SL6 Removed Position A connects Crystal Y1 as an external MCLK clock source. Position B connects MCLK SMA/SMB 

connector for use as a clock input or an ADC internal clock output. 
SL7 A Selects between an external or on-board AVDD1 source. Supplies AVDD1 from the ADP1720 (5 V) (U8) 

(default). 
SL8 to SL9 A Selects between a 5 V and 2.5 V LDO supply for AVDD1. Supplies AVDD1 with 5 V (default). 
SL10 A Selects the voltage applied to the AVDD1 pin. Operates using the supply set up by Link SL8 to Link SL9 

(default). When inserted in Position B, sets the AVDD1 voltage to 3.3 V supply from the ADP1720 (3.3 V) 
regulator. 

SL11 A Selects the voltage applied to analog input during on-board noise test (LK5 to LK20 inserted). Position A 
connects to the AD7173-8 REFOUT pin. Position B connects to GND. Position C connects to AVSS. 

SL12 to SL15 Inserted Connects AVSS and AGND for single-supply operation. To operate in split supply mode, remove these links. 
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SOCKETS AND CONNECTORS 

Table 2. Connector Details 

Connector Function Connector Type Manufacturer 
Manufacturer 
Number Order Code1 

J1 Connector to the SDP-B 120-way connector, 
0.6 mm pitch 

Hirose FX8-120S-SV(21) FEC1324660 

A0 to A3 Analog inputs to ADC Straight PCB mount 
SMB/SMA jack 

Tyco 1-1337482-0 Not applicable 

J3 External bench top voltage supply for 
the EVAL-AD7173-8SDZ 

Power socket block, 
3-pin, 3.81 mm pitch 

Phoenix 
Contact 

MC 1,5/ 3-G-3,81 FEC3704737 

J4 External ac-to-dc adapter input for the 
EVAL-AD7173-8SDZ, 7 V to 9 V 

DC power 
connectors, 2 mm 
SMT power jack 

Kycon KLDX-SMT2-
0202-A 

MOUSER 806-
KLDX-SMT20202A 

J5 External bench top voltage supply 
option for AVDD1/AVDD2 and IOVDD 
inputs on the AD7173-8 

Screw terminal block, 
3.81 mm pitch 

Phoenix 
Contact 

MKDS 1/4-3.81 FEC3704592 

J8 GPIO terminal Power socket  block, 
4-pin, 3.81 mm pitch 

Phoenix 
Contact 

MC 1,5/ 4-G-3,81 FEC3704749 

J10 and 
J12 

Analog input terminal block; wired 
connection to external source or sensor 

Power socket  block, 
8-pin, 3.81 mm pitch 

Phoenix 
Contact 

MC 1,5/ 8-G-3,81 FEC3704774 

J14 Analog input terminal block; wired 
connection to external source or sensor 

Power socket block, 
6-pin, 3.81 mm pitch 

Phoenix 
Contact 

MC 1,5/ 6-G-3,81 FEC3704762 

J15 Optional header 7-way, 2.54 mm pin 
header 

Samtec SSW-107-01-T-S FEC1803478 

J16 Optional header 7-way, 2.54 mm 
socket 

Samtec TLW-107-05-G-S FEC1668499 

 
1 Order codes starting with FEC are for Farnell. 

 

SERIAL INTERFACE 
The EVAL-AD7173-8SDZ evaluation board connects via the 
serial peripheral interface (SPI) to the Blackfin® ADSP-BF527 
on the SDP-B. There are four primary signals: CS, SCLK, and 
DIN (all inputs), and one output from the ADC, DOUT/RDY.  

To operate the EVAL-AD7173-8SDZ in standalone mode, 
disconnect the AD7173-8 serial interface lines from the 120-pin 
header by removing the 0 Ω R9 through R13 links. Use the test 
points to connect the signals to an alternative digital capture setup. 

 

 

 

 

POWER SUPPLIES 
Power the evaluation board from the ac-to-dc adapter 
connected to J4, or from an external bench top supply applied 
to J3 or J5. Linear LDOs generate the required voltages from the 
applied input voltage (VIN) rail when using J3 or J4. Use J5 to 
bypass the on-board regulators. The regulators used are the 5 V 
fixed output voltage and 2.5 V adjustable output voltage 
ADP1720 devices, which supply the AVDD1 and AVDD2 rails 
to the ADC; the ADP1720 (3.3 V) supplies the IOVDD rail. Use 
the ADP7104 (5 V) to supply 5 V for the SDP-B controller 
board. Each supply is decoupled where it enters the board and 
again at each device in accordance with the schematic. Table 3 
shows the various power supply configurations available, 
including split supply operation. 
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Table 3. Power Supply Configurations1 
Configuration Input Voltage Range Description 
Single Supply (Regulated) 7 V to 9 V The 7 V to 9 V input is regulated to 5 V for AVDD1/AVDD2 and 3.3 V for 

IOVDD. This also powers the external 5 V reference. See the Single Supply 
(Regulated) section in the Power Supply Configurations section. 

Single Supply (Unregulated) 7 V to 9 V, 5 V, and 3.3 V The input is unregulated and connects directly to AVDD1/AVDD2 and 
IOVDD from J5. The 7 V to 9 V input powers the external 5 V reference. See the 
Single Supply (Unregulated) section in the Power Supply Configurations section. 

Split Supply (Regulated) 7 V to 9 V and −2.5 V The 7 V to 9 V input is regulated to 2.5 V for AVDD1/AVDD2 and 3.3 V for 
IOVDD. The 7 V to 9 V input powers the external 5 V reference, and the −2.5 V 
input is connected to AVSS directly (unregulated). See the Split Supply 
(Regulated) section in the Power Supply Configurations section. 

Split Supply (Unregulated) 7 V to 9 V, ±2.5 V, and 
3.3 V 

The input is unregulated and connects directly to AVDD1/AVDD2 and 
IOVDD from J5. The 7 V to 9 V input powers the external 5 V reference. See the 
Split Supply (Unregulated) section in the Power Supply Configurations section. 

 
1 Only one configuration can be used at a time. 
 

POWER SUPPLY CONFIGURATIONS 
Single Supply (Regulated) 

There are two available power supply options for the single 
supply (regulated) configuration. 

• An ac-to-dc adapter (included) connected to J4. Set LK2 to 
Position B. 

• A bench top power supply connected to J3. Set LK2 to 
Position A and ensure that AVSS = AGND = 0 V. 

Set all other links and solder links to the default settings as 
outlined in Table 1. 

Single Supply (Unregulated) 

To set up the board, use the following procedure: 

1. Move SL5 to Position A and SL7 to Position B. 
2. Connect the two terminals of J5 labeled AGND and AVSS. 
3. Connect 0 V (GND) to J5 at the terminal labeled AGND. 
4. Connect 5 V to J5 at the terminal labeled AVDD. 
5. Connect 3.3 V to J5 at the terminal labeled IOVDD.  
6. Connect the 7 V to 9 V input to either J3 or J4. 

Set all other links and solder links to the default settings as 
outlined in Table 1. 

Split Supply (Regulated) 

To set up the board, use the following procedure: 

1. Remove SL12 to SL15. These links connect AVSS to AGND. 
2. Connect a bench top power supply to J3 and set LK2 to 

Position A. Make sure that AVSS = −2.5 V in this case. 
3. Set LK1 to Position B. This sets the input to the power 

monitor circuitry to work with the lower AVDD1 supply of 
2.5 V. 

Set all other links and solder links to the default settings as 
outlined in Table 1. 

 

 

Split Supply (Unregulated) 

To set up the board, use the following procedure: 

1. Move SL5 to Position A and move SL7 to Position B. 
2. Remove SL12 to SL15. 
3. Connect 0 V (GND) to J5 at the terminal labeled AGND. 
4. Connect 2.5 V to J5 at the terminal labeled AVDD. 
5. Connect −2.5 V to J5 at the terminal labeled AVSS. 
6. Connect 3.3 V to J5 at the terminal labeled IOVDD. 
7. Connect 7 V to 9 V to either J3 or J4. Connect or disconnect 

the AVSS terminal of J3 to the AVSS terminal of J5. 
8. Set LK1 to Position B. This sets the input to the power monitor 

circuitry to work with the lower AVDD1 supply of 2.5 V. 

Set all other links and solder links set to the default settings as 
outlined in Table 1. 

ANALOG INPUTS 
The EVAL-AD7173-8SDZ primary analog inputs can be applied 
in two separate ways. 

• J10, J12, and J14 connectors on the left side of the board 
• A0 to A3 SMB/SMA footprints on the evaluation board 

The analog inputs route directly to the associated analog input 
pins on the AD7173-8, provided that the LK5 to LK20 links 
(on-board noise test) are removed. The EVAL-AD7173-8SDZ 
software is set up to analyze dc inputs to the ADC. The 
AD7173-8 input buffers work for dc input signals. 

REFERENCE OPTIONS 
The EVAL-AD7173-8SDZ includes an external 5 V reference, 
the ADR445. The AD7173-8 includes an internal 2.5 V reference. 
The default operation is to use the external reference input, 
which is set to accept the 5 V ADR445 on the evaluation board. 

Choose the reference in the SETUPCONx registers associated 
with Setup 0 to Setup 7 to select the reference used for 
conversions by the AD7173-8. 

Change between the internal and external references by 
accessing the AD7173-8 register map in the evaluation software. 
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EVALUATION BOARD SOFTWARE 
SOFTWARE INSTALLATION 
The EVAL-AD7173-8SDZ evaluation kit includes software on a 
CD. Double-click the setup.exe file from the CD to run the 
installer. The default installation location for the software is 
C:\Program Files\Analog Devices\AD717xEvak+\. 

Install the AD717x Eval+ software before connecting the 
evaluation board and SDP-B board to the USB port of the PC. 
This ensures that the evaluation system is correctly recognized 
when connected to the PC. 

There are two parts to the installation. 

1. AD717x Eval+ software installation. 
2. AD717x Eval+ Dependencies 

a. SDP-B board drivers  
b. Ssrc SVG plug-in installation 
c. Microsoft .Net Framework v3.5 

Warning 

To ensure the PC correctly recognizes the evaluation system, the 
evaluation software drivers must be installed before connecting the 
EVAL-AD7173-8SDZ evaluation board and SDP-B boards to the 
USB port of the PC. 

Installing the AD717x Eval+ Software 

To install the AD717x Eval+ software take the following steps: 

1. With the SDP-B disconnected from the USB port of the 
PC, insert the AD717x Eval+ software installation CD into 
the CD-ROM drive. Double-click the setup.exe file to begin 
the evaluation board software installation. 

2. The default installation location for the software is 
C:\Program Files\Analog Devices\AD717x Eval+\. 

3. A dialog box appears asking for permission to allow the 
program to make changes to the PC. Click Yes to proceed 
(see Figure 3). 

 
Figure 3. AD7173-8 User Account Control Permission Dialog Box 

4. Select a location to install the software and click Next. 
Figure 4 shows the default locations displayed when the 
dialog box opens. To select another location click Browse.  

 
Figure 4. AD717x Eval+ Installation, Selecting the Location for Software 

Installation 

5. A license agreement appears. Read the agreement, select I 
accept the License Agreement, and click Next. 

 
Figure 5. AD717x Eval+ Installation, Accepting the License Agreement 

6. A summary of the installation displays. Click Next to 
continue. 

 
Figure 6. AD717x Eval+ Installation, Reviewing a Summary of the 

Installation 
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7. The message in Figure 7 appears when the installation is 
complete. 

 
Figure 7. AD717x Eval+ Installation Complete 

Installing the Eval+ Dependencies 

After installation of the evaluation software is complete, a 
welcome window displays to install the Eval+ Dependencies. 

1. With the SDP-B board still disconnected from the USB 
port of the PC, make sure all other applications are closed, 
then click Install.  

 
Figure 8. Eval+ Dependencies Setup, Beginning the Drivers Installation 

2. The Ssrc SVG plug-in will install first, then the SDP-B 
drivers, and finally the .Net Framework. 

3. If using Windows 8 or Windows 10 see the Installing the 
.Net Framework v3.5 on Windows 8 and Windows 10 
section. 

4. To complete the drivers installation click Close. This closes 
the installation setup wizard. 

 
Figure 9. Eval+ Dependencies Setup, Completing the Driver Setup Wizard 

5. Before using the evaluation board, the user must restart  
the PC. 

 
Figure 10. Restarting the PC 

Installing the .Net Framework v3.5 on Windows 8 and 
Windows 10 

Windows 8 and Windows 10 have a built in installer for the .Net 
Framework v3.5. In order to run this software the user will need an 
internet connection and may need administrator privileges. 
Complete the following steps to install the software. If unable to 
install the .Net Framework contact your system administrator. 

1. When the Eval+ Dependencies installer reaches the .Net 
Framework, the window shown in Figure 11 will appear. 

 
Figure 11. Restarting the PC 

2. Follow the steps in the installation wizard to complete the 
installation. 
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3. If the window in Figure 11 does not appear; v3.5 may 
already be installed. To check if the software is already 
installed open Control Panel > Programs > Programs 
and Features and select Turn Windows features on or off. 
Check that the .Net Framework v3.5 is enabled. 

SETTING UP THE SYSTEM FOR DATA CAPTURE 
After completing the steps in the Software Installation section 
and the Evaluation Board Hardware section, set up the system 
for data capture using the following steps. 

1. Allow the Found New Hardware Wizard to run after the 
SDP-B board is connected to the PC. (If using Windows 
XP, search for the SDP-B drivers. Choose to automatically 
search for the drivers if prompted by the operating system.) 

2. Check that the board is connecting to the PC correctly 
using the Device Manager. 

3. Access the Device Manager by right clicking My 
Computer, then Manage. A dialog box appears asking for 
permission to allow the program to make changes to the 
PC. Click Yes. The Computer Management box appears. 
Click Device Manager from the list of System Tools (see 
Figure 12). 

4. The SDP-B board appears under ADI Development Tools. 
This indicates that the driver software has installed and the 
board is connected to the PC correctly. 

 
Figure 12. Device Manager 

LAUNCHING THE SOFTWARE 
After completing the steps in the Setting up the System for Data 
Capture section, launch the AD717x Eval+ software using the 
following steps: 

1. From the Start menu, click Programs > Analog Devices > 
AD717x Eval+.  

2. The dialog box in Figure 13 appears, select AD7173 
Evaluation Board. The main window of the software box 
displays as shown in Figure 16. 

 
Figure 13. AD7173-8 Evaluation Board Selection 

3. If the EVAL-AD7173-8SDZ evaluation system is not 
connected to the USB port via the SDP-B, when the 
software is launched the Select Interface dialog box appears 
(see Figure 14). Connect the evaluation board to the USB 
port of the PC, wait a few seconds, click Refresh and the 
option shown in Figure 13 appears.  

 
Figure 14. Evaluation Board Selection, No Board Connected 

4. The AD717x Eval+ software can also be used without 
connecting hardware. Click the Simulation button and the 
options shown in Figure 15 appear. This  simulation mode 
uses a model and allows the AD7172-2, AD7172-4, 
AD7173-8, AD7175-2, AD7175-8, AD7176-2, or  
AD7177-2 to be evaluated. 

 
Figure 15. Evaluation Board Selection Simulation 
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EVALUATION BOARD SOFTWARE OPERATION 

 
Figure 16. Configuration Tab of the AD7173-8 Eval+ Software in Hardware Mode 
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Figure 17. Configuration Tab of the AD7173-8  Eval+ Software in Simulation Mode

OVERVIEW OF THE MAIN WINDOW 
The main window of the AD717x Eval+ software displays the 
significant control buttons and analysis indicators of the AD717x 
Eval+ software. The main window is divided into five tabs. 

• Configuration 
• Waveform 
• Histogram 
• Modelled Performance 
• Registers 

CONFIGURATION TAB (1) 
Figure 16 shows the Configuration tab when Hardware Mode 
is selected and Figure 17 shows the Configuration tab when 
Simulation mode is selected. The controls highlighted in  
Figure 17 are only available in Simulation mode. 

Evaluation Mode (2) 

The Evaluation Mode indicator displays the current evaluation 
mode. To switch between modes, click the Select Product 
button and the dialog box shown in Figure 13 appears. 

Tutorial Button (3) 

Click the tutorial button to open a tutorial and access additional 
information on using the AD717x Eval+ software. 

Functional Block Diagram (4) 

The functional block diagram of the ADC shows each of the 
separate functional blocks within the ADC. Clicking a 
configuration pop-up button on any of the functional blocks 
opens the configuration pop-up window for the block selected. 
Not all blocks have a configuration button. 

Configuration Pop-up Button (5) 

Each configuration pop-up button opens a different window 
that allows the configuration of the relevant functional block. 

Analog and Digital Supply Voltage (6, 7, and 14) 

These input fields are used to take the supply voltage levels 
selected for the AD7173-8. Checks are performed to ensure the 
power supply voltage levels entered are within the specified 
limits. These power supply voltage levels are also used for the 
modelled performance to calculate the power dissipation. 

External Reference (Ext. REF) (8) 

The Ext. REF input fields set the positive and negative external 
reference voltage values. The difference is used for calculating 
the results for both the Waveform and Histogram tabs. The 
evaluation board has an external 5 V ADR445 reference, which 
can be bypassed by removing R32. Change the external 
reference values in Ext. REF to ensure correct calculation of 
results in the Waveform and Histogram tabs. 
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Register Configuration Summary(9) 

Click the Summary button to display the selected configuration 
of the AD7173-8 this includes the channel configuration, 
information on each of the individual steps, and information on 
any error present. 

Reset ADC (10) 

Click the Reset ADC button to perform a software reset of the 
AD7173-8 . The AD7173-8 does not have a hardware reset pin, 
to perform a hard reset the power must be removed from the 
board. The software reset has the same effect as a hard reset. 

Menu Bar (11) 

The menu bar has three section: File, Edit, and Help. 

File 

There are three options available in the File drop-down menu: 
Save, Load, and Generate.  

Save 

Save allows the user to save register configurations or waveform 
data. Register configurations can be saved as a JSON file or a 
header file. If the configuration is only used in the AD717x 
Eval+ software environment then it is recommended to use the 
JSON setting. Waveforms are saved as .csv files and the user is 
prompted to save the register configuration as well.  

Load 

Load allows the user to load saved register configurations or 
waveform data. In order to load a header into AD717x Eval+ it 
must be in the same format as one that is saved from AD717x 
Eval+. The header file can be used when developing firmware. 
When loading the waveform data the user is prompted to load 
the register configuration. This allows the software to correctly 
analyze the data.  

Edit 

There are two options in the Edit drop-down menu; Change 
Product Selection and Reset ADC. Change Product Selection 
performs the same action as the Select Product button and 
Reset ADC performs the same action as the Reset ADC button. 

 

Help 

The Help drop-down menu provides links to extra information 
about the AD7173-8 , which includes links to the AD7173-8 
product page, EVAL-AD7173-8SDZ evaluation board user 
guide, AD7173-8  datasheet, and No-OS Drivers. Selecting the 
AD717x Eval+ Tutorial opens the tutorial outlined in the 
Tutorial Button (3) section. For details on the current version of 
the software the About option opens a dialog box displaying the 
current version of the software and relevant licenses. 

Status Bar (12) 

The status bar displays the busy indicator and status updates, 
such as Analysis Completed and Reset Completed during 
software use. 

Device Error (13) 

The Device Error LED icon illuminates when an ADC error is 
detected or when a cyclic redundancy check (CRC) error occurs. 
The CRC functionality on the AD7173-8 is disabled by default 
and must be enabled for the Device Error indicator to work. 
Specific information on the error can be found in the Register 
Configuration Summary(9) section. 

External MCLK Frequency (15) 

This field sets the external MCLK frequency. External MCLK 
Frequency (15)] is only visible on the front panel when an 
external clock source is selected by the ADC. It is used by the 
functional model for modelled performance.  

Analog Input Voltage (16) 

These fields are only available when simulation mode is 
selected.These inputs allow the analog input voltages to be set 
and can be changed at any time while in simulation mode. 

External SCLK Frequency (17) 

This input field sets the external SCLK frequency for the SPI 
interface. This field is only available in simulation mode to 
determine if the SCLK frequency is within the permitted range.  
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WAVEFORM TAB (18) 
Figure 18 shows the Waveform tab of the AD717x Eval+ software. 

Sampling Mode (19) 

This control is unrelated to ADC mode. The user can capture a 
defined sample set, single capture; or continuously gather 
batches of samples, repeated capture. The user can also select 
data logging that runs similar to repeated capture, but posts the 
results to a .csv file. When saving, the .csv file prompts the user 
to save the register configuration. This is necessary to load the 
data back into the software for analysis. 

Samples (20) 

The Samples field control sets the number of samples gathered 
per batch. Single capture returns the number enters into the 
Samples control. Repeated capture keeps returning batches of 
the number entered into the Samples control until stopped by 
the user. 

Sample (21) 

Click the Sample button to start gathering ADC results. Results 
appear in the waveform graph (22). See Figure 18. 

Waveform Graph and Controls (22 and 23) 

The data waveform graph shows each successive sample of the 
ADC output. Zoom in on the data using the control toolbar 
(labeled 23 in Figure 18). Click the x-axis and y-axis to change 
the scales on the graph. 
 
 
 
 

Channel Selection (24) 

The channel selection control allows the user to choose which 
channels display on the data waveform graph (23). These controls 
only affect the display of the channels and have no effect on the 
channel settings in the ADC register map. 

Noise Analysis (25) 

The Noise Analysis section displays the results of the noise 
analysis for the selected analysis channel, which includes both 
noise and resolution measurements. 

Analysis Channel (26) 

The Noise Analysis section and histogram graph show the 
analysis of the channel selected via the Analysis Control drop-
down menu. 

Display Units and Axis Controls (27) 

Click the Display Units drop-down menu to select the unit 
displayed in the graph. This control affects both the waveform 
graph and the histogram graph. The axis controls can be 
switched between dynamic and fixed. When dynamic is 
selected, the axis automatically adjusts to show the entire range 
of the ADC results after each batch of samples. When fixed is 
selected, the user can program the axis ranges; the axis ranges 
do not automatically adjust after each batch of samples. 
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Figure 18. Waveform Tab of the AD7173-8Evaluation Software 
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HISTOGRAM TAB (28) 
Figure 19 shows the Histogram tab of the AD717x Eval+ 
Software. 

Histogram Graph and Controls (29 and 30) 

The data histogram graph (29) shows the number of times each 
sample of the ADC output occurs. The control toolbar (30) in the 
histogram graph allows the user to zoom in on the data (see  
Figure 19). Click the x-axis and y-axis to change the scales on the 
graph (see Figure 19).

 

 
Figure 19. Histogram Tab of the AD7173-8 Eval+ Software 

 
12

02
4-

1 1
9

29

28

30

Downloaded from Arrow.com.

http://www.analog.com/ad7173-8?doc=EVAL-AD7173-8SDZ_UG-631.pdf
http://www.arrow.com


UG-631 EVAL-AD7173-8SDZ User Guide 
 

Rev. A | Page 16 of 34 

 
Figure 20. Filter Profiles of the AD7173-8 Evaluation Software 

 

MODELLED PERFORMANCE TAB (31) 
The Modelled Performance tab shows a number of ADC 
performance parameters, which are calculated using the ADC 
functional model. There are three main sections to the 
Modelled Performance tab; Filter Profile, Filter Step Response, 
and Timing Diagram/Power. These can be selected using the 
drop-down menu (33). 

Analysis Channel (32) 

The Analysis Channel drop-down menu selects the channel to 
be evaluated by the functional model. 

Filter Profile (33) 

The Filter Profile drop-down menu allows the user to switch 
between the three sections of the Modelled Performance tab. 
Figure 20 shows the Modelled Performance tab when filter 
profile is selected. 

Filter Profile Graph (34) 

This graph shows the frequency response for the selected digital 
filter. The graph controls allows the user to zoom in on the data. 
Click the x-axis and y-axis to change the scales on the graph. 

Filter Rejection (35) 

This section shows the rejection/attenuation of the digital filter 
over the rejection bandwidth (Rej.BW) for f1 and f2 in decibels; 
f1, f2, and Bandwidth can be changed. 

Filter Performance (36) 

This section shows the timing information about the data rate 
of the selected output. It shows the ADC initial settling time 
(Tsettle), the first frequency notch (Fnotch), and the actual 
sampling frequency (fADC). 
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Figure 21. Filter Step Response of the AD7173-8 Evaluation Software 

Filter Step Response (37) 

This drop down menu allows the user to switch between the 
three sections of the Modelled Performance tab. Figure 21 shows 
the tab when Filter Step Response is selected.  

Step Response Graph (38) 

This graph shows how long the filter takes to settle when the 
voltage is stepped from one voltage to the next. For this analysis, 
it is assumed the ADC is continuously converting on only one 
channel. 

Step Configuration (39) 

Step Configuration allows the user to set the voltage before and 
after the step and the step position. Step position is set as a 
percentage where 0% is 1/fADC and 100% is 2/fADC.  

Step Response (40) 

This section shows timing information about the data rate of 
the selected output. It shows fADC, Tsettle, and the settling time 
between conversions, 1/fADC.  

Graph Units (41) 

Use this control to switch the step response between percentages, 
volts, and codes. 
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Figure 22. Timing Diagram/Power of the AD7173-8 Evaluation Software 

Timing Diagram/ Power (42) 

This drop down menu allows the user to switch between the 
three sections of the Modelled Performance tab. Figure 22 
shows the Modelled Performance tab when Filter Step 
Response is selected.  

Estimated Power Consumption (43) 

This section shows the total power consumption of the device 
in the current configuration, as well as, the current consumption 
on each of the power supply rails. Please take note that the 
estimated power consumption is for continuous conversion 
mode only and no other mode of operation is supported. 

Timing Diagram (44) 

This graph shows the digital interface timing diagram for the 
current configuration. The graph shows the timing for both the 
configuration of the ADC, and the subsequent data reads from 
the ADC. 

 

 

 

 

 

 

12
02

4 
-1

22

42

43

44

Downloaded from Arrow.com.

http://www.analog.com/ad7173-8?doc=EVAL-AD7173-8SDZ_UG-631.pdf
http://www.arrow.com


EVAL-AD7173-8SDZ User Guide UG-631 
 

Rev. A | Page 19 of 34 

 
Figure 23. Registers Tab of the AD7173-8 Evaluation Software 

REGISTERS TAB (45) 
Figure 23 shows the Registers tab. 

Register Tree (46) 

This control shows the full register map in a tree control. Each 
register is shown; click the expand button next to each register 
to show all the bit fields contained within that register.  

Register (47) 

The Register control allows the user to change the individual 
bit of the register selected in the register tree (46) by clicking the 
bits or by programming the register value directly into the number 
control field on the right. 

Bitfields (48) 

This list shows all the bit fields of the register selected in the 
register tree (46). Change the values by using the drop-down 
box or by directly entering a value into the number control field 
on the right. 

Documentation (49) 

The Documentation field contains the documentation for the 
register or bitfield selected in the register tree (46). 

Save(50) and Load (51) 

The Save (50) and Load (51) buttons allow the user to save the 
current configuration of AD7173-8 by saving off the register 
map setting to a file and load the setting from that same file. 
When using these buttons the register configurations are saved 
and loaded as JSON files. 

EXITING THE SOFTWARE 
To exit the software, click the close button at the top right corner 
of the main window (see Figure 16). 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 

 
Figure 24. AD7173-8 Schematic 
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Figure 25. Amplifier Schematic 
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Figure 26. Power Supply Sequencing Schematic 
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Figure 27. Regulator Schematic 
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Figure 28. SDP-B Connector Schematic 
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Figure 29. Analog Inputs Schematic 
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Figure 29. Top Printed Circuit Board (PCB) Silkscreen 

 

 
Figure 30. Bottom PCB Silkscreen 
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Figure 31. Layer 1 Component Side 

 

 
Figure 32. Layer 2 Ground Plane 
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Figure 33. Layer 3 Power/Ground Plane 

 

 
Figure 34. Layer 4 Solder Side 
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ORDERING INFORMATION 
BILL OF MATERIALS 

Table 4. 
Name Part Description Manufacturer Part Number Stock Code 
A0 through A3, EXTREF+, 
EXTREF−, MCLK 

Straight PCB mount SMB jack, 
keep hole clear of solder. Do not 
insert. 

TE Connectivity 1-1337482-0 Do not insert 

C1, C17, C43, C47, C83 through 
C84 

Ceramic capacitor, 6.3 V, X5R, 
0603, 4.7 µF 

Murata GRM188R60J475K FEC 173-5527 

C2, C12 through C14,C18, C20 
through C21, C34, C38, C44, C50 
through C55, C58, C60, C71, C73, 
C78 through C79, C81, C85, C87, 
C89, C91, C101 through C102 

Capacitor, 0603, 0.1 µF, 16 V Multicomp B0603R104KCT FEC 940-6140 

C15, C45 through C46 Ceramic capacitor, 10 V, X5R, 0603, 
4.7 μF 

KEMET 
Electronics 
Corp. 

C0603C475K8PACTU FEC 157-2625 

C3, C5, C7 through C9, C19, C22 
through C24, C26 through C33, C35 
through C37, C40 through C42, C59, 
C61 through C67 

Ceramic capacitor, not inserted, 
0402 

Not applicable Not applicable Do not insert 

C69 through C70, C75 through 
C76, C93 through C100 

Ceramic capacitor, not inserted, 
0603 

Not applicable Not applicable Do not insert 

C10 through C11 Capacitor, 0603, 1 μF, 6.3 V Not applicable Not applicable Do not insert 
C4, C6 Capacitor, 0805, 50 V, X7R, 1 μF Murata GRM21BR71H105KA12L FEC 1735541 
C56 through C57, C77 Capacitor, 0603, 1 μF, 6.3V Murata GRM188R70J105KA01D FEC 184-5765 
C16 Ceramic capacitor, not inserted, 

0402 
Not applicable Not applicable Do not insert 

C25, C72, C86, C88 Ceramic capacitor, 10 μF, 16 V, 
X5R, 0805 

Murata GRM21BR61C106KE15L 490-3886-1-ND 

C39, C48 through C49, C80, C82 Ceramic capacitor, 50 V, X5R, 1210 Murata GRM32ER61H106K FEC 184-5764 
D1 through D2, D6 Red LED, high intensity (>90 mCd), 

0603 
Broadcom Ltd. HSMC-C191 FEC 855-4528 

D4 LED, SMD green Osram LGQ971 FEC 1226372 
D5 Zener Diode, 0.5 W, 5.1 V Vishay BZT52B5V1-V-GS08 FEC 1617767 
AVSS, GND1 through GND6, REF+, 
REF−, REFOUT, S1 through S8, S1’ 
through S8’, TDIN, TDIN1, TDOUT, 
TDOUT1, TERROR, TERROR1, TP, 
TSCLK, TSCLK1, TSYNC, TSYNC1, 
T\CS, T\CS1 

Test point, not inserted, keep hole 
clear of solder 

Not applicable Not applicable Do not insert 

J1 120-way connector, 0.6 mm pitch HIROSE FX8-120S-SV(21) FEC 1324660 
J2 PC-SCREWTERM-3WAY Phoenix 

Contact 
1727023 Do not insert 

J3 Socket terminal block, 3.81 mm 
pitch 

Phoenix 
Contact 

MC 1.5/3-G-3.81 FEC 370-4737 

J4 CON\BARREL_SMD_2MM_KLDX-
SMT2-0202-A 

Mouser KLDX-SMT2-0202-A 806-KLDX-
SMT20202A 

J5 SCREWTERM-4 Phoenix 
Contact 

MKDS1/4-3.81 FEC 370-4592 

J6 POWER_SKT_3.81MM_4WAY, keep 
clear of solder 

Phoenix 
Contact 

MC1.5/4-G-3.81 Do not insert 

J7 SCREWTERM-4, keep clear of 
solder 

Phoenix 
Contact 

MKDS1/4-3.81 Do not insert 

J8 POWER_SKT_3.81MM_4WAY Phoenix 
Contact 

MC1.5/4-G-3.81 FEC 370-4749 and 
FEC 370-4920 
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Name Part Description Manufacturer Part Number Stock Code 
J9 SCREWTERM-8_RA, keep clear of 

solder 
Phoenix 
Contact 

1727078 Do not insert 

J10 POWER_SKT_3.81MM_8WAY Phoenix 
Contact 

MC 1,5/ 8-G-3,81 FEC 370-4774 and 
FEC 370-4956 

J11 SCREWTERM-8_RA, keep clear of 
solder 

Phoenix 
Contact 

1727078 Do not insert 

J12 POWER_SKT_3.81MM_8WAY Phoenix 
Contact 

MC 1,5/ 8-G-3,81 FEC 370-4774 and 
FEC 370-4956 

J13 SCREWTERM-6-RA, keep clear of 
solder 

Phoenix 
Contact 

MKDS1/6-3.81 Do not insert 

J14 POWER-SKT-3.81MM_6WAY Phoenix 
Contact 

MC 1,5/ 6-G-3,81 FEC 370-4762 and 
FEC 370-4944 

J15 CON\7HEADER Samtec SSW-107-01-T-S FEC 1803478 
J16 CON\7HEADER Samtec TLW-107-05-G-S FEC 1668499 
L1 through L4 Ferrite bead, 0.3 Ω at dc, 1000 Ω at 

100 MHz, 350 mA, 0805 
TE Connectivity BMB2A1000LN2 FEC 119-3421 

LK1 through LK2 3-pin (3 × 1) 0.1" header and 
shorting block in A 

Harwin M20-9990346 and 
M7566-05 

FEC 1022249 and 
FEC 150-411 

LK5 through LK21 2-pin (2 mm Pitch) header and 
shorting shunt 

Harwin M22-2010205 and  
M22-1920005 

FEC 671915 and 
FEC 510944 

Q1 SI2304DDS-T1-GE3 Fairchild 
Semiconductor 

2N7002 FEC 1853257 

Q2 NPN-BCX19, SOT23 ON 
Semiconductor 

MMBT3904LT1G FEC 1459100 

R1 Resistor, not inserted, 0603 Multicomp MC 0.063W 0603 0R Do not insert 
R28, R29, R50, R52 Resistor, not inserted, 0402 N/A N/A Do not insert 
R2 through R4, R7, R48 Resistor, 100 K, 0.063 W, 1%, 0603 Multicomp MC 0.063W 0603 1% 

100 K 
FEC 9330402 

R5, R6, R8, R42 through R44, R71, 
R125 

Resistor, 1 %, 0603 Multicomp MC 0.063W 0603 1% 10 
K 

FEC 933-0399 

R45 Resistor, thick film, 10 kΩ, 
62.5 mW, 5 % 

Yageo RC0402JR-1310KL FEC 179-9316 

R9 through R13, R19 through R22, 
R26 through R27, R30, R32, R34 
through R41, R46 through R49, 
R51, R53, R56 through R59, R62 
through R70, R72, R73, R79, R85 
through R85, R89, R93, R94, R98 
through R101, R104, R108, R111, 
R113, R119 through R122, R132, 
R136, R142, R146, R153 through 
R156 

Resistor, 0603, 1 %, 0R Vishay CRCW06030000Z0EA FEC 146-9739 

R33, R90, R112, R114 Resistor, 0402 Vishay  Do not insert 
R61, R81 through R83, R87, R91 
through R92, R95 through R97, 
R105, R126, R127 through R128, 
R133, R137 through R139, R143, 
R147 through R149, R152, R157, 
R158 

Resistor, 0603, 1 %, 0R Vishay CRCW06030000Z0EA Do not insert 

R14 Resistor, 0402, 1 %, 39 K Multicomp MC 0.063W 0603 1% 39K FEC 9331158 
R15, R17, R18, R24 Resistor, 0603 10 k2 1 % Vishay CRCW060310K2FKEA FEC 1652829 
R25, R123 Resistor, 0603, 1 %, 30 k1 Vishay CRCW060330K1FKEA FEC 1469798 
R80 Resistor, 0603, thick film, 1 % Vishay CRCW06031K00FKEA Do not insert 
R31, R78, R88, R107, R135, R145 SMD Resistor, 0603 Not applicable Not applicable Do not insert 
R54 Resistor, thick film, 4.53 kΩ, 

63 mW, 1 % 
Vishay CRCW06034K53FKEA FEC 2138399 

R55 Resistor, 0603, 1 %, 61R9 Vishay CRCW060361R9FKEA FEC 2141253 
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Name Part Description Manufacturer Part Number Stock Code 
R60 Resistor, thick film, 2.4 kΩ, 0603, 100 

mW, 1 % 
Yageo RC0603FR-072K4L FEC 1799329 

R66, R75 through R77 Resistor, 0603, thick film, 1 % Vishay CRCW06031K00FKEA FEC 1469740 
R74, R103, R106, R131, R134, R141, 
R144, R151 

Resistor, 0603, 1 K Panasonic ERA3AEB102V FEC 1577605 

R86 Resistor, 0402, 60 K4 Multicomp MC 0.0625W 0402 1 % 
60K4 

FEC 1803729 

R102, R129, R140, R150 Resistor, 0603, 10R Bourns Inc. CR0603-FX-10R0GLF FEC 2008331 
SL0, SL1 4-way Solder Link (Use 0r 0603 

Resistor) 
Not applicable Insert in Link Position 

"A” 
FEC 933-1662 

SL2, SL3 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"A" 

FEC 933-1662 

SL4 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"A" 

FEC 933-1662 

SL5 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"B" 

FEC 933-1662 

SL6 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Not applicable Do not insert 

SL7 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"A" 

FEC 933-1662 

SL8 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"A" 

FEC 933-1662 

SL9, SL10 2-way Solder Link (Use 0r 0603 
Resistor) 

Not applicable Insert in Link Position 
"A" 

FEC 933-1662 

SL11A R0603, 0r Vishay CRCW06030000Z0EA FEC 146-9739 
SL11B, S11C R0603, DNI Vishay CRCW06030000Z0EA Do not insert 
SL12 through SL15 Resistor, 1206, 0R Multicomp MC 0.125W 1206 0R FEC 9336974 
STAR3 Ground link (copper short) Not applicable Not applicable Not applicable 
U1 32 K I2C Serial EEPROM Microchip 

Technology Inc. 
24LC32A-I/MS FEC1331330 

U2 Linear Regulator 5 V, 20 V,  
500 mA, Ultralow Noise, CMOS 

Analog Devices, 
Inc. 

ADP7104ARDZ-5.0 ADP7104ARDZ-
5.0 

U3 Quad Voltage Monitor and 
Sequencer 

Analog Devices, 
Inc. 

ADM1185ARMZ-1 ADM1185ARMZ-1 

U4 5 V XFET Reference Analog Devices, 
Inc. 

ADR445BRZ ADR445BRZ 

U5 ADC Analog Devices, 
Inc. 

AD7173-8BCPZ AD7173-8BCPZ 

U6 Dual Op-Amp Analog Devices, 
Inc. 

AD8656ARZ AD8656ARZ 

U7 Ultra Low Power, Low Distortion 
ADC Driver, 4nV/rtHz 

Analog Devices, 
Inc. 

ADA4940-1ACPZ ADA4940-1ACPZ 

U8 50 mA, High Voltage, Micropower 
Linear Regulator −5V 

Analog Devices, 
Inc. 

ADP1720ARMZ-5-R7 ADP1720ARMZ-5-
R7 

U9 Fully Differential Funnel Amplifier Analog Devices, 
Inc. 

AD8475ARMZ AD8475ARMZ 

U10 Dual Op-Amp Analog Devices, 
Inc. 

AD8656ARZ AD8656ARZ 

U11 Linear Regulator, 50 mA, 3.3 V, 
MSOP-8 

Analog Devices, 
Inc. 

ADP1720ARMZ-3.3-R7 ADP1720ARMZ-
3.3-R7 

U12 50 mA, High Voltage, Micropower 
Adjustable Linear Regulator  

Analog Devices, 
Inc. 

ADP1720ARMZ-R7 ADP1720ARMZ-
R7 

V1 through V4, X1 through X2 Linear Regulator, 50 mA, 3.3 V, 
MSOP-8 

Analog Devices, 
Inc. 

Not applicable Do not insert 

Y1 Miniature Crystal SMD Epson FA-20H, 16 MHz, 10 
PPM, 9 PF 

FEC 171-2814 
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ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice 
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED 
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF 
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE 
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable 
United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of 
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby 
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 

©2014-2018 Analog Devices, Inc. All rights reserved. Trademarks 
and registered trademarks are the property of their respective 
owners.  UG12024-0-1/18(A)  
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